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1 Overzicht
1.1 Modulair ontwerp

Het systeem Access Professional Edition (hieronder Access PE genoemd) biedt onafhankelijke
toegangscontrole voor kleine en middelgrote bedrijven. Het bestaat uit meerdere modules:
– LAC-service: een proces dat voortdurend communiceert met de LAC's (Local Access

Controllers - voortaan controllers genoemd). AMC's (Access Modular Controllers) worden
gebruikt als controllers.

– Configurator
– Personnel Management (Personeelsbeheer)
– Logviewer
– Alarm Management (Alarmbeheer)
– Video Verification (Videoverificatie)

1.2 Server- en clientmodules
De modules kunnen worden onderverdeeld in server- en clientmodules.
Voor de LAC-service moet een continu contact met de controllers worden onderhouden. De
reden hiervoor is ten eerste dat de LAC-service continu berichten van de controllers ontvangt
m.b.t. bewegingen, aanwezigheid en afwezigheid van kaarthouders en op de tweede plaats dat
deze gegevenswijzigingen verstuurt, bijv. toewijzing van nieuwe kaarten aan de controllers,
maar vooral ook omdat deze controles op meerdere niveaus uitvoert
(toegangsvolgordecontroles, anti-passbackcontroles, willekeurige controles).
De Configurator moet op de server uitgevoerd worden, maar kan tevens op een client-
werkstation worden geïnstalleerd en vanaf het werkstation worden bediend.
De modules Personnel Management (Personeelsmanagement) en LogViewer
(Logboekweergave) behoren tot de Client-component en kunnen ook op de server worden
uitgevoerd, of op een andere pc die over een netwerkverbinding met de server beschikt.
De volgende controllers kunnen worden gebruikt.
– AMC2 4W (met vier Wiegand-lezerinterfaces) - kan worden uitgebreid met een AMC2 4W-

EXT
– AMC2 4R4 (met vier RS485-lezerinterfaces)
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2 Algemeen
2.1 Inleiding

Access PE is een toegangscontrolesysteem dat is ontworpen om kleine en middelgrote
installaties optimale veiligheid en flexibiliteit te bieden.
De stabiliteit en uitbreidbaarheid van Access PE is gebaseerd op een ontwerp met drie lagen:
de eerste laag is het beheerdersniveau met de besturingsservices. Alle beheerderstaken
worden op dit niveau uitgevoerd, zoals het registreren van nieuwe kaarten of het toewijzen van
toegangsrechten.
De tweede laag wordt gevormd door de Local Access Controllers (LAC's), die de verschillende
groepen deuren of ingangen beheren. Zelfs wanneer het systeem offline is, kan een LAC
onafhankelijk beslissingen nemen over toegangscontrole. LAC's zijn verantwoordelijk voor de
bediening van de ingangen, het bepalen van openingstijden, of verzoeken om PIN-codes bij
cruciale toegangspunten.
De derde laag bestaat uit kaartlezers.
De communicatie tussen client, server en kaarthouders is met AES versleuteld.
Met de Access PE-versie voor meerdere gebruikers kunt u met meerdere werkstations het
systeem besturen. Aanpasbare gebruikersrechtniveaus regelen de toegang en garanderen de
veiligheid. Hierdoor is het bijvoorbeeld mogelijk om vanaf het ene werkstation kaartgegevens
bij te werken, terwijl vanaf een ander werkstation wordt gecontroleerd of een bepaalde
werknemer in het gebouw aanwezig is.
Access PE biedt een uitzonderlijk flexibele configuratie van toegangsrechten, tijdmodellen en
toegangsparameters. De volgende lijst geeft een overzicht van de belangrijkste functies:
Snelle en eenvoudige toewijzing van kaarten
Kaarten (max. drie) kunnen handmatig aan personen worden toegewezen of met behulp van
een dialooglezer die via een seriële verbinding is aangesloten op een pc. Alle toegewezen
kaarten zijn actief. Bij het upgraden van een kaart wordt de oude kaart automatisch
overschreven en ongeldig gemaakt. Dit betekent dat oude kaarten geen toegang meer bieden,
zelfs als de verantwoordelijke persoon de kaart vergat te annuleren of er niet in is geslaagd dit
te doen.
Toegangsrechten (inclusief groepsrechten)
Elke persoon kan groepsrechten overnemen naast de individuele rechten die aan hem zijn
toegewezen. Rechten kunnen gebieds- en tijdgebonden zijn en met een nauwkeurigheid van
één minuut worden beperkt. Groepsrechten kunnen worden gebruikt om toegangsrechten toe
te wijzen aan en te beperken voor een of meer kaarthouders tegelijk. Groepsrechten kunnen
afhankelijk gemaakt worden van tijdmodellen die de toegang beperken tot bepaalde tijden van
de dag.
Toegangsregistratie
Door gebieden te definiëren kunt u controleren of het juiste traject wordt gevolgd en dit
wanneer nodig afdwingen. Zelfs zonder controle maakt deze configuratie het mogelijk om de
locatie van een kaarthouder weer te geven.
Anti-Passback
Wanneer een kaart gelezen is, kan deze voor een gedefinieerde periode geblokkeerd worden
zodat hij niet opnieuw gebruikt kan worden voor toegang in dezelfde toegangszone. Op die
manier kan "passback" worden voorkomen, waarbij een gebruiker zijn kaart over een barrière
aan een andere, niet-geautoriseerde persoon geeft om deze toegang te bieden.
Automatisch annuleren van kaarten na de einddatum
Bezoekers en tijdelijk personeel hebben vaak slechts een beperkte periode toegang nodig.
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Kaarten kunnen voor een specifieke periode worden geregistreerd, zodat ze automatisch
ongeldig worden nadat de betreffende periode is verstreken.
Tijdmodellen en dagmodellen
Aan een kaarthouder kunnen specifieke tijdmodellen toegewezen worden, die de
toegangsuren voor die persoon bepalen. Tijdmodellen kunnen flexibel gedefinieerd worden
door gebruik te maken van dagmodellen die bepalen hoe specifieke weekdagen, weekends,
feestdagen en bijzondere dagen afwijken van normale werkdagen.
Identificatie via PIN-code
Een persoon kan in plaats van een kaart een speciale PIN-code gebruiken om naar binnen te
gaan.
Verificatie via PIN-code
De toegang tot bijzonder vertrouwelijke gebieden kan worden beperkt met behulp van extra
PIN-codes. Deze beveiliging kan op haar beurt afhankelijk gemaakt worden van tijdmodellen,
zodat een PIN-code bijvoorbeeld alleen vereist is gedurende feestdagen of buiten normale
werktijden.
Flexibel deurbeheer
Flexibel definiëren van parameters voor afzonderlijke deurmodellen maakt een optimaal
evenwicht tussen veiligheid en comfort mogelijk. De alarmonderdrukkingsperiode kan per deur
worden ingesteld om te bepalen hoe lang een deur geopend mag blijven. Na het verstrijken
van deze periode kan het toegangspunt desgewenst worden vergrendeld in combinatie met
een alarmsysteem.
Periodiek vrijgeven van deur
U kunt de toegang vergemakkelijken door deuralarmen te onderdrukken om deuren gedurende
een bepaalde periode vrij te geven. De vrijgaveperiodes van deuren kunnen handmatig of
automatisch via een tijdmodel worden gedefinieerd.
Tijd en aanwezigheid
Voor toegangszones kunnen parameters gedefinieerd worden voor het registreren van de
binnenkomst en het vertrek van personen ten behoeve van het tijds- en aanwezigheidsbeheer.
Type ID-kaart
De grafische invoegmodule Card Personalization (CP) is volledig in het
toegangscontrolesysteem geïntegreerd zodat de operator kaarten kan maken zonder tussen
verschillende toepassingen te hoeven schakelen.
Toewijzen van foto's
Zelfs als de invoegmodule Card Personalization (CP) niet is geactiveerd, blijft het mogelijk om
fotografische identificatie te importeren en aan kaarthouders te koppelen.
Offline locking system (Offline-afsluitsysteem)
Gebieden die om een bepaalde reden niet zijn afgesloten door het online
toegangscontrolesysteem met hoge beschikbaarheid, kunnen offline alsnog worden
afgesloten.
Beheer van video-apparatuur
Ingangen kunnen extra worden voorzien van camera's om de bewegingen van aanwezige
personen te registreren en te volgen.

2.2 Aanmelden gebruiker
De volgende toepassingen zijn beschikbaar. Raadpleeg de betreffende
gebruikershandleidingen voor meer informatie:
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Personnel Management (Personeelsbeheer)

Configurator

Logviewer (Logboekweergave)

Map and Alarm Management (Plattegrond-
en alarmbeheer)

Video Verification (Videoverificatie)

Bericht!
Aanmelden op de client is alleen mogelijk als de LAC-service wordt uitgevoerd op de server.

Aanmelden op client
De toepassingen van het systeem zijn beveiligd tegen niet-geautoriseerd gebruik. De
standaardwachtwoorden bij het eerste gebruik zijn:
– Gebruikersnaam: bosch
– Wachtwoord: bosch

Na het invoeren van een gebruikersnaam en wachtwoord wordt de knop Change Password
(Wachtwoord wijzigen) actief.
Na drie mislukte pogingen duurt het enige tijd voordat opnieuw kan worden aangemeld. Dit
geldt voor de knoppen "Start the Application" (Toepassing starten) en "Change
Password" (Wachtwoord wijzigen).
In de bovenste keuzelijst kunt u de gewenste taal voor interactie selecteren. Standaard is dat
de taal die is gebruikt om de toepassing te installeren. Als een volgende gebruiker de
toepassing niet opnieuw opstart, blijft de eerder ingestelde taal actief. Het is dan mogelijk dat
er een dialoogvenster in een ongewenste taal wordt weergegeven. Om dit te voorkomen, dient
u zich nogmaals bij Access PE aan te melden.
Access PE toepassingen kunnen worden uitgevoerd in de volgende talen:
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– Engels
– Duits
– Frans
– Japans
– Russisch
– Pools
– Chinees (PRC)
– Nederlands
– Spaans
– Portugees (Brazilië)

Bericht!
Alle voorzieningen zoals apparaatnamen, labels, modellen en gebruikersautorisatieschema's
worden weergegeven in de taal waarin ze zijn ingevoerd. Knoppen en labels die afhankelijk
zijn van het besturingssysteem, worden mogelijk weergegeven in de taal van het
besturingssysteem.

Nadat u op de knop Change Password (Wachtwoord wijzigen) hebt geklikt, voert u een
nieuwe gebruikersnaam en een nieuw wachtwoord in dit dialoogvenster in:

Bericht!
Vergeet niet het wachtwoord te wijzigen!

Met de knop Start the application (Toepassing starten) worden de rechten van de gebruiker
gecontroleerd en op basis hiervan de toepassing gestart. Als het systeem de
aanmeldingsgegevens niet kan verifiëren, verschijnt het volgende foutbericht: Wrong
username or password! (Gebruiker of wachtwoord is onjuist).
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2.3 Indeling van Personnel Management (Personeelsbeheer)
Het dialoogvenster bestaat uit de volgende onderdelen:

1 = Menubalk — bevat dialoogvensterfuncties die worden
weergegeven in de menuvolgorde.

2 = Werkbalk — bevat sneltoetsen voor de belangrijkste
dialoogvensterfuncties.

3 = Titelbalk — komt overeen met de standaardvensters van
Windows en bevat knoppen voor het minimaliseren of
sluiten van het dialoogvenster. De naam van de
geregistreerde gebruiker wordt tussen vierkante haakjes
weergegeven.

4 = Personeelstabel — een lijst van alle personen die in het
systeem bekend zijn, samen met hun
aanwezigheidsstatus (autorisatie en locatie).

5 = Dialoogvensterveld — de eerste keer dat dit veld wordt
geopend of wanneer er geen gebruiker zich heeft
aangemeld, wordt hier een neutrale afbeelding
weergegeven. Wanneer er een item is geselecteerd in de
personeelslijst, worden hier de gegevens van deze
persoon weergegeven.

6 = Online-kaartleesgegevens — toont de laatste vijf
personen (samen met hun foto uit de database) die hun
kaart bij de geselecteerde ingang door de kaartlezer
hebben gehaald.

7 = Apparaatstatus - toont de geconfigureerde apparaten
en ingangen en hun verbindingsstatus. Maakt
deurbesturingsfuncties mogelijk.
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8 = Gebeurtenissen — fouten worden weergegeven door
een knipperende rode balk (knippert drie keer) met
informatie over de oorzaak.

9 = Statusbalk — toont informatie over knoppen en
menuopties die worden geselecteerd met de muis. De
statusweergave voor het
kaartpersonaliseringsprogramma, dialooglezers en LAC-
service.

2.4 Werkbalk van Personnel Management (Personeelsbeheer)
De volgende functies zijn beschikbaar via de menu's of werkbalkknoppen.

Functie Pictogr
am

Beschrijving

Menu Options (Opties)

Vernieuwen De personeelslijst vernieuwen.

Afsluiten Hiermee sluit u de toepassing
Access PE Personnel
Management af.

Menu Persons (Personen)

New person
(Nieuwe persoon)

Hiermee opent u een leeg
dialoogvenster voor het
invoeren van personeels- en
kaartgegevens.

Modify person
(Persoon
wijzigen)

Hiermee opent u het
dialoogvenster voor personeels-
en kaartgegevens met de
gegevens van de geselecteerde
persoon.

Delete person
(Persoon
verwijderen)

Hiermee verwijdert u de
geselecteerde persoon (nadat u
dit hebt bevestigd in het
venster dat verschijnt).

Transmit selected
person to the LAC
service
(Geselecteerde
persoon naar LAC-
service
verzenden)

Hiermee verzendt u de
gegevens van de geselecteerde
persoon naar de LAC-service,
waarna wordt gemeld of het
verzenden met succes is
uitgevoerd.
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Functie Pictogr
am

Beschrijving

Transmit all
persons to the
LAC service (Alle
personen naar
LAC-service
verzenden)

Hiermee verzendt u de
gegevens van alle personen
naar de LAC-service, waarna
wordt gemeld of het verzenden
met succes is uitgevoerd.

Set all persons
absent (Alle
personen instellen
als afwezig)

Hiermee stelt u alle personen in
als afwezig (nadat u dit hebt
bevestigd in het venster dat
verschijnt).

Set location of all
persons present
to unknown
(Locatie van alle
aanwezige
personen instellen
op onbekend)

Hiermee stelt u de locatie van
alle personen in op onbekend
en schakelt u de
toegangsregistratie voor de
volgende aanmelding van elke
persoon uit.

Personen
opruimen

Opent het dialoogvenster voor
het opruimen van de
personendatabase

View/print reports
(Rapporten
weergeven/
afdrukken)

Opent het dialoogvenster voor
het maken van rapportlijsten.

List
control
(Lijstco
ntrole)

Alleen de personen uit de
geselecteerde groep worden
weergegeven.

Menu View (Beeld)

Symbol bar
(Werkbalk)

De werkbalk weergeven/
verbergen. Standaard =
weergeven.

Status&balk De statusbalk weergeven/
verbergen. Standaard =
weergeven.

Personnel data:
(Personeelsgegev
ens:)
Toestand
Card No.
(Kaartnr.)
Personnel-No.
(Personeelsnr.)

Selecteer de kolommen die
naast de symbool- en
naamkolom in de personeelslijst
moeten worden weergegeven.
Standaard = State (Status) -
Company (Bedrijf) - Location
(Locatie)
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Functie Pictogr
am

Beschrijving

Bedrijf
Personnel Group
(Personeelsgroep)
Telefoon
Locatie

Menu Door management (Deurbeheer)

open door (Deur
openen)

Deze
functie
s zijn
ook
beschik
baar
via het
snelme
nu
(met
de
rechter
muiskn
op op
de
gewens
te
deur/
ingang
klikken
).

De ingang die in de
apparatenlijst is geselecteerd,
wordt weergegeven en kan
worden geopend (één keer).

Long-term open
(Langdurig
openen)

De ingang die in de
apparatenlijst is geselecteerd,
wordt weergegeven en kan
(langdurig) worden geopend.

lock door (Deur
vergrendelen)

De ingang die in de
apparatenlijst is geselecteerd,
wordt weergegeven en kan
worden vergrendeld.

Menu Tools

User logon
(Gebruiker
aanmelden)

Hiermee kunt u zich aan- of
afmelden bij Personnel
Management
(Personeelsbeheer).

Execute the
Configurator
(Configurator
starten)

Hiermee start u Configurator en
brengt u gegevens over van
Personnel Management
(Personeelsbeheer).

Execute log
viewer (Log
Viewer starten)

Hiermee start u Log Viewer
(Logboekweergave) en brengt u
gegevens over van Personnel
Management
(Personeelsbeheer).
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Functie Pictogr
am

Beschrijving

Execute Video
verification (Video
Verification
starten)

Start de toepassing voor het
uitvoeren van de
videoverificatie.

Execute Map &
Alarm
Management
(Map & Alarm
Management
starten)

Start de toepassing Map &
Alarm Management voor het
beheren van plattegronden en
alarmen.

Video panel
(Videopaneel)

Toont vier displays in het
dialoogvenster voor
afzonderlijke
videocamerabeelden.

Properties Hiermee opent u een
dialoogvenster met algemene
systeeminstellingen.

Menu ? (Help)

Help topics (Help-
onderwerpen)

Dit Help-bestand openen.

About Access
Personal Edition -
Personnel
Management
(Info...)

Hiermee geeft u informatie over
Personnel Management
(Personeelsbeheer) weer.
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2.4.1 Personen opruimen
Als u een aantal personen wilt verwijderen die niet meer in het systeem hoeven te blijven,
selecteert u Cleanup persons (Personen opruimen) in het vervolgkeuzemenu Persons
(Personen).

Een lijst met een aantal personen wordt weergegeven. U kunt personen selecteren met
verschillende filtercriteria. Personen met bestaande gebruikersrechten worden niet
weergegeven. Het volgende voorbeeld heeft betrekking op personen waaraan geen kaart is
toegewezen.
– Selecteer de personen die moeten worden verwijderd.
– Klik op de knop Delete selected persons (Geselecteerde personen verwijderen)

onderaan.
– Klik op het zoeksymbool om de selectie bij te werken.

2.5 Configuraties wijzigen

2.5.1 Configuraties van registratielezers wijzigen
1. Open de toepassing Access PE Personnel Management.
2. Klik op Tools (Extra) in de menubalk van de toepassing Access PE Personnel

Management.
3. Klik op Properties (Eigenschappen) in de vervolgkeuzelijst.
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– Het dialoogvenster Change Configuration (Configuratie wijzigen) wordt geopend.
– In het dialoogvenster Change Configuration (Configuratie wijzigen) heeft alleen het

eerste gedeelte betrekking op de Enrollment Reader (Registratielezer).
4. Stel de parameterwaarden in en configureer de gegevens van de Enrollment Reader

(Registratielezer) overeenkomstig de specificaties van de fabrikant.

Bericht!
Door een registratielezer te koppelen aan een dialoogstationlezer, wordt de tijdelijke
registratie van kaartgegevens tijdelijk geblokkeerd.

Vereiste instellingen voor de ondersteunde registratielezers:

Lezertype Kaarttype Baudrate Pariteit Databits Stopbits

LECTUS enroll 5000 MD -
MIFARE-gegevensrecord

– BOSCH-code
(63-bits)

– Serienumme
r kaart
(CSN)

9600 geen 8 1

Interflex USB Hitag, Mifare – BOSCH-code
(63-bits)

– Serienumme
r kaart
(CSN)

AMC-lezers Wiegand, 4R4

Rosslare ARD-1200EM USB 9600 geen 8 1

Delta 1200 Prox RS232 9600 geen 8 1

Delta 1200 iClass RS232 57600 even 8 1
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Lezertype Kaarttype Baudrate Pariteit Databits Stopbits

Delta 1200 USB Hitag, Legic,
Mifare

9600 geen 8 1

Delta 1200 RS232 Hitag, Legic,
Mifare

19200 geen 8 1

Bericht!
De Delta 1200-serie en de Rosslare ARD-1200EM-serie zijn niet geëvalueerd door UL.

2.5.2 Kaartpersonaliseringsfuncties toestaan en blokkeren
Als u het systeem hebt geïnstalleerd met de module Card Personalization (CP), is het
overeenkomstige selectievakje in de instellingen standaard ingeschakeld.
1. Open de toepassing Access PE Personnel Management.
2. Klik op Tools (Extra) in de menubalk van de toepassing Access PE Personnel

Management.
3. Klik op Properties (Eigenschappen) in de vervolgkeuzelijst.
– Het dialoogvenster Change Configuration (Configuratie wijzigen) wordt geopend.
4. Schakel het selectievakje CP system for card personalization (CP-systeem voor

kaartpersonalisering) in om alle kaartpersonaliseringsfuncties toe te staan.
5. Schakel het selectievakje CP system for card personalization (CP-systeem voor

kaartpersonalisering) uit om alle kaartpersonaliseringsfuncties te blokkeren.

2.5.3 Verbinding maken en verbreken met een LAC-service
1. Open de toepassing Access PE Personnel Management.
2. Klik op Tools (Extra) in de menubalk van de toepassing Access PE Personnel

Management.
3. Klik op Properties (Eigenschappen) in de vervolgkeuzelijst.
– Het dialoogvenster Change Configuration (Configuratie wijzigen) wordt geopend.
4. Het selectievakje Connect to LAC service (Verbinden met LAC-service) is standaard

ingeschakeld (aanbevolen). Hierdoor kan verbinding worden gemaakt met de LAC-service.
5. Schakel het selectievakje Connect to LAC service (Verbinden met LAC-service) uit om de

verbinding met de LAC-service te verbreken.

Bericht!
Als de verbinding met de LAC-service is verbroken, worden berichten van en naar de service
niet gedeeld (bijv. Online-kaartleesgegevens)

2.5.4 Dialoogvenster voor bewerken en weergeven van interne kaartinformatie
in- en uitschakelen
Het dialoogvenster voor het bewerken en weergeven van interne kaartinformatie is vereist
wanneer configuraties van kaartgegevens moeten worden gewijzigd overeenkomstig de
standaardinstellingen van het bedrijf.
1. Open de toepassing Access PE Personnel Management.
2. Klik op Tools (Extra) in de menubalk van de toepassing Access PE Personnel

Management.
3. Klik op Properties (Eigenschappen) in de vervolgkeuzelijst.
– Het dialoogvenster Change Configuration (Configuratie wijzigen) wordt geopend.
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4. Schakel het selectievakje Do not show dialog for edit and view internal card information
(Dialoogvenster voor het bewerken en weergeven van interne kaartinformatie niet
weergeven) in om het dialoogvenster voor het bewerken en weergeven van interne
kaartinformatie uit te schakelen.

5. Schakel het selectievakje Do not show dialog for edit and view internal card information
(Dialoogvenster voor het bewerken en weergeven van interne kaartinformatie niet
weergeven) uit om het dialoogvenster voor het bewerken en weergeven van interne
kaartinformatie uit te schakelen.

2.5.5 THAI-lettertype voor rapporten in- en uitschakelen (speciaal lettertype
gebruiken)
1. Open de toepassing Access PE Personnel Management.
2. Klik op Tools (Extra) in de menubalk van de toepassing Access PE Personnel

Management.
3. Klik op Properties (Eigenschappen) in de vervolgkeuzelijst.
– Het dialoogvenster Change Configuration (Configuratie wijzigen) wordt geopend.
4. Schakel het selectievakje Enable THAI font for reports (use special font) (THAI-

lettertype inschakelen voor rapporten (speciaal lettertype gebruiken)) in om de Thaise
taal en lettertypen in te schakelen voor rapporten.

5. Schakel het selectievakje Enable THAI font for reports (use special font) (THAI-
lettertype inschakelen voor rapporten (speciaal lettertype gebruiken)) uit om de Thaise
taal en lettertypen uit te schakelen voor rapporten.

Bericht!
Deze functie is alleen beschikbaar in de Engelse taaldimensie.

2.5.6 Registratie via lezers aangesloten op AMC
Zorg dat ten minste één lezer is geconfigureerd met een Deurmodel 06c, het deurmodel voor
registratie.
– Start de Configurator en selecteer een Lokale toegangscontroller (LAC) (bijvoorbeeld

AMC2 Wiegand).
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Klik op het symbool Ingangen en voeg een nieuwe ingangslezer toe:

Het dialoogvenster Entrances (Ingangen) wordt geopend:
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In dit dialoogvenster voert u de volgende handelingen uit:
– Voer een omschrijving in (bijv. Registratielezer AMC)
– Selecteer een LAC en een groep-ID (GID)
– Selecteer een lezertype (bijv. Wiegand)
– Selecteer een nummer tussen 1 en 8 als adres voor de registratielezer
Klik op OK om de configuratie van de registratie te bevestigen.

Om de geconfigureerde registratielezer aan een specifiek werkstation toe te wijzen, schakelt u
over op de APE-client.
– Select Tool > Properties (Tool selecteren > Eigenschappen).

Selecteer een beschikbare registratielezer om het registratieproces te starten.
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Controleer of uw registratielezer online is.
Indien u niet direct een reactie hebt ontvangen, dient u het dialoogvenster Personnel
Management (Personeelsmanagement) te openen.
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3 Personnel Management (Personeelsbeheer)
Dit dialoogvenster is de hoofdtoepassing van de werkstations. Behalve gegevensopslag en
bewerkingsfaciliteiten toont dit dialoogvenster ook locaties van personen en eventuele
blokkeringen tegen deze personen. U kunt daarnaast systeembewakingsprocedures uitvoeren
via de deurbedieningsfuncties en apparaatstatusweergaven.

3.1 Personenlijst
De personenlijst bevat alle personen die in het systeem staan. Standaard worden achternaam,
voornaam en bedrijf of afdeling weergegeven. Een aparte kolom met symbolen biedt de
volgende aanvullende informatie over de status van de persoon of kaart:

De persoon heeft geen kaart

De persoon is afwezig.

De persoon is aanwezig.

De persoon is afwezig en geblokkeerd. Het
dialoogvenster bevat ook een knipperlichtje.

De persoon is aanwezig maar geblokkeerd. Het
dialoogvenster bevat ook een knipperlichtje.

De standaard lijstweergave met de kolommen Symbol (Symbool), Name (Naam) en Company/
Dept. (Bedrijf/Afd.) kan voor elk werkstation worden aangepast. Gebruik het menu View >
Personnel Data (Beeld > Personeelsgegevens) om kolommen toe te voegen of te verwijderen.
Weergegeven kolommen zijn gemarkeerd met een vinkje. Wanneer u een weergegeven kolom
nogmaals selecteert, schakelt u de weergave uit, en omgekeerd.
De volgende extra kolommen zijn beschikbaar:
– card No. (kaartnr.)
– Personnel No. (Personeelsnr.)
– Company / Dept. (Bedrijf / Afd.)
– Personnel Group (Personeelsgroep)
– Telephone (Telefoon)
– Location (Locatie) (als gebieden zijn gedefinieerd)
– Picture (Foto)
– Last access (Laatste toegang)
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Bericht!
Mogelijk worden niet alle geselecteerde kolommen weergegeven als de huidige breedte van
het lijstvenster te klein is. In dat geval past u de breedte van het venster aan. U kunt
desgewenst ook de volgorde van de kolommen in het venster wijzigen. De volgorde van de
kolommen kan worden gewijzigd door de kolomkoppen naar de gewenste plaats te slepen.
Houd er rekening mee dat bij het verbreden van de personenlijst ook de breedte van het
dialoogvenster aan de rechterkant van de lijst wordt aangepast.

De werkbalk bevat een keuzelijst met invoervak voor het filteren van de personenlijst.
Standaard worden alle personen weergegeven onder Employees (Personeel) of Visitors
(Bezoekers).

Opmerking: als u een extra groep toevoegt (bijv. VIP's), worden de leden van die groep
automatisch weergegeven onder Employees (Personeel).
U kunt de kolom Picture (Foto) toevoegen aan de personenlijst. U kunt de kolom tonen of
verbergen via het menu View > Personnel data > Picture (Beeld > Personeelsgegevens >
Foto).
Deze kolom bevindt zich uiterst rechts. U zult daarom soms moeten bladeren door de
personenlijst om deze zichtbaar te maken. Andere kolommen zijn wellicht verborgen.

Bericht!
Deze afbeeldingen passen in de lengte van de kolom. Het is daarom moeilijk personen te
identificeren wanneer het display klein is. De belangrijkste reden voor het weergeven van de
afbeeldingen is om gebruikers in staat te stellen snel te controleren voor welke personen er
nog geen foto is opgeslagen.
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3.2 Dialoogvenster voor personeelsgegevens
Als u een item selecteert in de personenlijst, worden de gegevens van de betreffende persoon
weergegeven in het dialoogvenster aan de rechterkant.

In dit dialoogvenster kunt u niet alleen de belangrijkste personeelsgegevens weergeven maar
ook verschillende functies activeren.

Weergave/Functie Beschrijving

Name (Naam)
(Title - First name - Last
name) (Titel - Voornaam
- Achternaam)

Alleen weergave - voor wijzigingen
gebruikt u het wijzigingsvenster -
Personeels- en kaartgegevens, pagina
36.

Company/Dept.
(Bedrijf/Afd.)

Personnel-No.
(Personeelsnr.)

Card No. (Kaartnr.)

Photo (Foto)

Current Status (Huidige
status)

Aanwezigheids-/
afwezigheidsweergave inclusief
datum.

Set present (Instellen
als aanwezig), Set
absent (Instellen als
afwezig)

Afhankelijk van de huidige status
kunt u de persoon hier als aanwezig
of afwezig instellen.
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Weergave/Functie Beschrijving

Notes (Opmerkingen) Ruimte voor eigen tekst over deze
persoon. Max. 50 tekens.

Memo Ruimte voor eigen memotekst over
deze persoon. Max. 300 tekens.

Memo preview/ Print
Memo
(Memovoorbeeld/Memo
afdrukken)

De memotekst kan worden
weergegeven of afgedrukt volgens
een vooraf gedefinieerde afdruklay-
out.

Telephone (Telefoon) Het telefoonnummer of ander
nummer waarop deze persoon te
bereiken is.

Location (Locatie) De locatie van een persoon
weergeven en wijzigen. U kunt een
willekeurig gebied selecteren,
evenals de standaardwaarde --
unknown -- (onbekend).

Special messages on
the reader (Speciale
berichten op de lezer)

elke regel van het scherm kan
maximaal 20 tekens bevatten

Name (Naam) De naam van de persoon zoals deze
moet worden weergegeven door
lezers die over deze
weergavefunctie beschikken.

On arrival (Bij
aankomst)

Speciale welkomsttekst.

On leaving (Bij vertrek) Speciale afscheidstekst.

Card status
(Kaartstatus)

– valid (geldig)
– explicitly blocked

(expliciet
geblokkeerd)

– 3x wrong PIN input
(3x onjuiste invoer
PIN-code)

– Selected for
random screening
(Geselecteerd voor
willekeurige
controle)

De kaartstatus weergeven en
wijzigen. De volgende
kaartparameters kunnen hier
worden ingesteld.
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3.3 Apparaatstatus
Het derde deelvenster van het hoofdvenster voor personeelsbeheer, Device status
(Apparaatstatus), bevindt zich onder de personeelslijst.
De apparaatstatus wordt naast de lijst met logboekmeldingen weergegeven.

De volgende symbolen geven de apparaatstatus aan:

Apparaatstatus Symbool

Controller is online

Controller is offline

Verbinding met de controller kan niet worden
vastgesteld

Verbinding met lezer - OK

Verbinding met lezer is niet correct

Verbinding met lezer kan niet worden
vastgesteld.

Bedieningsmodus/
deurstatus

Symbool voor 
Normaal

Symbool voor
Permanent open

Symbool voor
Permanent
vergrendeld

Gesloten

Normaal open N.v.t.

Open met time-out N.v.t. N.v.t.

Open onderbroken N.v.t.

Onbekend

Defect

Een verbindingsstoring wordt ook aangegeven door een balkje onder aan het dialoogvenster,
dat rood knippert bij het openen van het dialoogvenster.
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Bericht!
De statusweergave van Wiegand-kaartlezers kan misleidend zijn. Omdat een Wiegand-
kaartlezer niet kan reageren op statusverzoeken, wordt deze met gedefinieerde parameters
als online weergegeven zolang zijn controller online is.

Bedieningselementen
Deze functie is alleen beschikbaar als de aangemelde gebruiker deurbedieningsrechten heeft -
Gebruikersrechten.
Deze functie is alleen beschikbaar als de aangemelde gebruiker deurbedieningsrechten heeft.
Naar items die in de apparaatstatuslijst zijn geselecteerd en waarmee een verbinding tot stand
is gebracht, kunnen opdrachten worden verzonden via het snelmenu (klikken met de
rechtermuisknop) of het menu Door management (Deurbeheer).

De naam van het geselecteerde item wordt afgelezen in de context.

Open <Entrance> (Ingang
openen)

De geselecteerde ingang gaat
eenmaal open (om één persoon
door te laten).

Long-term open <Entrance>
(Ingang langdurig openen)

De geselecteerde ingang gaat
gedurende een langere tijd
open.

Lock <Entrance> (Ingang
vergrendelen)

De geselecteerde ingang wordt
vergrendeld.
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3.4 De online-kaartleesgegevens gebruiken
Online swipe (online-kaartleesgegevens) is een functie die een lijst weergeeft met de
toegangsgeschiedenis en de deurstatussen van een of meer geselecteerde ingangen in een
overzicht.

Maximaal 400 gebeurtenissen van de afgelopen 48 uur van de geselecteerde ingangen worden
in een lijst weergegeven in het deelvenster voor online-kaartleesgegevens. De gebeurtenissen
worden in real-time weergegeven.
Voor elke interactie van een persoon met een ingang (bijv. een referentie tonen), wordt op het
deelvenster voor online-kaartleesgegevens de volgende informatie weergegeven:
– Foto
– Datum
– Tijd
– Naam van de ingang
– Deurgebeurtenissen
– Beslissing van systeem inzake toegang

De kleuren van de verticale balken aan de linkerzijde van een gebeurtenis hebben de volgende
betekenis:

Kleur Betekenis

Groen Toegang verleend

Rood Toegang geweigerd

Helder Systeemberichten/waarschuwingen

3.4.1 De online-kaartleesgegevens openen
1. Open de toepassing Access PE Personnel Management.
– Het hoofdtoepassingsvenster wordt geopend.
2. Selecteer een vermelding in de apparaatstructuur.
3. Klik met de rechtermuisknop op de geselecteerde ingang.
4. Select Online swipe (Online-kaartleesgegevens) in het snelmenu.
– Het deelvenster Online swipe (Online-kaartleesgegevens) wordt geopend in de

rechterzijde van het hoofdtoepassingsvenster.
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– Maximaal 400 gebeurtenissen van de afgelopen 48 uur van een geselecteerde ingang
worden in een lijst weergegeven in het deelvenster voor online-kaartleesgegevens.

– Elke ingang die u kiest voor weergave in het deelvenster voor online-kaartleesgegevens
wordt gemarkeerd met een sterretje in de apparaatstructuur.

Als u de toegangsgeschiedenis van een extra ingang wilt weergeven, moet u expliciet Online
swipe (Online-kaartleesgegevens) selecteren in het snelmenu van de gewenste ingang in de
apparaatstructuur.

Bericht!
Nadat een andere ingang is geselecteerd in de apparaatstructuur, blijft de
toegangsgeschiedenis van de eerder geselecteerde ingangen weergegeven in het deelvenster
voor online-kaartleesgegevens.

3.4.2 Het deelvenster voor online-kaartleesgegevens verbergen en weergeven
Optie 1
1. Selecteer een actieve ingang (gemarkeerd met een sterretje) in de apparaatstructuur.
2. Klik met de rechtermuisknop op de geselecteerde ingang.
3. Selecteer Hide online swipe (Online-kaartleesgegevens verbergen) om het deelvenster

voor online-kaartleesgegevens te verbergen.
– Alle geselecteerde ingangen blijven gemarkeerd met een sterretje in de

apparaatstructuur.
Optie 2
1. Klik op View (Weergeven) in de hoofdmenubalk van de toepassing Access PE Personnel

Management.
2. Selecteer Hide online swipe (Online-kaartleesgegevens verbergen) om het deelvenster

voor online-kaartleesgegevens te verbergen.
– Alle geselecteerde ingangen blijven gemarkeerd met een sterretje in de

apparaatstructuur.
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3.4.3 Het deelvenster voor online-kaartleesgegevens uitschakelen
1. Klik op View (Weergeven) in de hoofdmenubalk van de toepassing Access PE Personnel

Management.
2. Selecteer Switch off online swipe (Online-kaartleesgegevens uitschakelen) om de online-

kaartleesgegevens uit te schakelen.
– Alle geselecteerde ingangen worden gereset en de sterretjes verdwijnen.

3.4.4 De opties voor weergave van online-kaartleesgegevens configureren
Optie 1
1. Klik op View (Weergeven) in de hoofdmenubalk van de toepassing Access PE Personnel

Management.
2. Selecteer Online swipe with… (Online-kaartleesgegevens met…)
– Een submenu met drie verschillende opties voor informatieweergave wordt weergegeven.

U kunt kiezen uit:
– Persoonsberichten weergeven
– Ingangsberichten weergeven
– Berichten van lezer weergeven

3. Selecteer een of meer opties voor informatieweergave.
– Alleen de geselecteerde opties voor informatieweergave worden weergegeven in de

online-kaartleesgegevens.

Optie 2
1. Klik met de rechtermuisknop op een gebeurtenisbericht in het deelvenster voor online-

kaartleesgegevens.
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– Een snelmenu met drie opties voor informatieweergave wordt weergegeven. U kunt
kiezen uit:
– Persoonsberichten weergeven
– Ingangsberichten weergeven
– Berichten van lezer weergeven

2. Selecteer een of meer opties voor informatieweergave.
– Alleen de geselecteerde opties voor informatieweergave worden weergegeven in de

online-kaartleesgegevens.

3.5 Videobeheer
De videocomponenten die worden geleverd bij het Access Professional Edition
toegangscontrolesysteem kunnen worden gebruikt als extra beheerfaciliteit voor speciale
ingangen, met als doel live-beelden te vergelijken met beelden die zijn opgeslagen in een
database en zo de omgeving te controleren. Het is ook mogelijk om speciale reacties op het
alarm te genereren met behulp van video-opnamen en om specifieke omgevingen te bewaken,
zelfs onafhankelijk van ingangen.
Daarnaast kunnen videocomponenten worden opgeroepen en gebruikt in Access PE in de
volgende gebieden.
– Videoverificatie: extra optische controlefuncties bij ingangen
– Alarmbeheer: speciaal geconfigureerde alarmmeldingen en ingangen kunnen worden

ondersteund door opgenomen videosequenties
– Videospecifieke weergaven: afspelen van huidige camerabeelden van maximaal vier

gelijktijdig vrij te configureren camera's
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Zie ook
– Video panel (Videopaneel), pagina 32
– Live-beeld, pagina 33

3.5.1 Video panel (Videopaneel)

(Videopaneel) Druk op de knop  in de werkbalk Personnel Management
(Personeelsbeheer) om het dialoogvensterveld te vervangen door een weergave met vier
video-beelden.

In het videopaneel kunt u maximaal vier camera's van verschillende ingangen selecteren.
De volgende functies zijn beschikbaar voor elk displayvenster.

Selectielijst U kunt een willekeurige camera selecteren
om in het toegangscontrolesysteem te laden
en deze op elk gewenst moment vervangen.

Slaat een momentopname van het actuele
beeld op als <device
name>_yyyyMMddhhmmsstttt.jpg in C:
\BOSCH\Access Professional Edition\PE
\Data\Video (standaardpad).

Start/beëindigt een video-opname van het
actuele beeld en slaat het op als <device
name>_yyyyMMddhhmmsstttt.vxx in C:
\BOSCH\Access Professional Edition\PE
\Data\Video (standaardpad).
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(= Point of Interest (Interessepunt)) Slaat
een momentopname van het actuele beeld
op — POI_ wordt toegevoegd aan het begin
van de bestandsnaam.
Er wordt ook een logboekbericht gemaakt
als markering.

Beelden voor videoweergave aanpassen
Een bepaalde selectie en rangschikking van camera's kan worden opgeslagen en vervolgens
later op naam worden opgeroepen. Dit bespaart tijd die anders zou zijn besteed aan het
handmatig selecteren en configureren van dezelfde weergave.
Configureer eerst handmatig de gewenste weergave door de camera's in de vensters te
positioneren die u het best uitkomen.
Geef de weergave vervolgens een betekenisvolle naam in de onderste keuzelijst en sla deze
naam op door op ENTER te drukken. Deze weergaven kunnen naderhand worden opgevraagd
met de naam uit dezelfde keuzelijst.
Op die manier kunnen operators verschillende cameraweergaven voor verschillende
doeleinden opslaan, bijv. om 's morgens binnenkomend en 's avonds vertrekkend personeel te
bewaken. Opgeslagen weergaven behoren bij het werkstation en niet bij de individuele
operator. Ze kunnen niet als zodanig worden bewerkt. Als u een weergave wilt wijzigen, roep
deze dan eerst op uit de keuzelijst, wis de naam met de

knop  rechts naast de keuzelijst, wijzig de camerastand, indien nodig, en sla die dan op
onder dezelfde naam als eerder is gebruikt, met behulp van de ENTER-toets.
Opgeslagen weergaven zijn specifiek voor een werkstation, niet voor een operator. Operators
kunnen dus door hun collega's aangepaste weergaven gebruiken.

3.5.2 Live-beeld
Behalve de deurbesturingsfuncties bevat het pop-upmenu dat ingangen en lezers in de
apparaatstatuslijst aangeeft, ook items om te verbinden met live-beelden.

Bericht!
Deze functies zijn niet beschikbaar in de apparaatstatuslijst in de LogViewer.

Er is een algemeen item voor elke geconfigureerde camera toegevoegd aan deze toegang. Als
het maximale aantal camera's geconfigureerd is, verschijnt het pop-upmenu voor de modus
Live image (Live-beeld) als volgt:
– Identificatiecamera
– Camera achteringang 1
– Camera achteringang 2
– Camera vooringang 1
– Camera vooringang 2

Wanneer u een camera selecteert, verschijnt het live-beeld op het display. Als u geen
personeelsrecord hebt geselecteerd, wordt het live-beeld weergegeven in het
dialoogvensterveld (in plaats van de tijd). Anders verschijnt het in een kleiner formaat rechts
van de apparaatstatuslijst.
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Als u een personeelsrecord selecteert om te bewerken terwijl het grote live-beeld wordt
weergegeven, schakelt de modus Live image (Live-beeld) naar een kleiner formaat.
Als de functie voor live-beelden voor een van de camera's actief is, bevat het popup-menu het
item Video off (Video uit) dat u kunt gebruiken om de standaardstatus te herstellen.

Bericht!
U kunt ook modus Live image (Live-beeld) activeren via de cameralijst op het tabblad Video
devices (Video-apparaten) door het gewenste lijstitem te selecteren.
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4 Personnel data (Personeelsgegevens)

Als u een nieuwe persoon wilt toevoegen, opent u een leeg dialoogvenster met de knop 
of via het menu Persons > New person (Personen > Nieuwe persoon).

Bericht!
Deze procedure geldt voor het maken van een nieuwe personeelsrecord. Als u echter
bestaande personeelsgegevens wilt bewerken, dubbelklikt u op een persoon in de

personeelslijst, of selecteert u een persoon en klikt u op de werkbalkknop . Hetzelfde
dialoogvenster wordt geopend maar in dat geval bevat het de gegevens van de geselecteerde
persoon.
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4.1 Personeels- en kaartgegevens
Het dialoogvenster Personal data and authorizations (Personeelsgegevens en autorisaties)
bevat alle relevante persoonlijke en kaartgegevens, evenals speciale kaartinformatie. U moet
ten minste een naam en een personeelsgroep voor de persoon opslaan in de database.
De volgende informatie kan worden opgeslagen:

Gegevensveld/
Invoerveld

Beschrijving

Person
(Persoon)

Title (Titel) Deze gegevens verschijnen hier in de
volgorde Title (Titel), First name
(Voornaam) en Last name (Achternaam). In
de personenlijst wordt de titel niet
weergegeven.

Last name
(Achternaam)

First name
(Voornaam)

Date of birth
(Geboortedatu
m)

De datum kan met cijfers worden ingevoerd
of met behulp van de kleine pijlknoppen
worden geselecteerd.

Bedrijf Het bedrijf of de afdeling mag 4 regels lang
zijn. U kunt een regeleinde invoeren met
behulp van Ctrl + ENTER. Max. 114 tekens.

Telephone
(Telefoon)

Wordt ook weergegeven bij de informatie
over de beschikbaarheid van de persoon.
Max. 30 tekens.

Valid from ...
to ... (Geldig
van ... tot ...)

Geef hier de geldigheidsperiode op voor
toegangscontrole. Als u de velden leeg laat,
is de geldigheid oneindig.

Personnel
group
(Personeelsgro
ep)

Invoer vereist. U moet een personeelsgroep
kiezen.

Card data (Kaartgegevens)

(Display of card
status)
(Weergave van
kaartstatus)

De huidige kaartstatus wordt met een
symbool weergegeven.

 Geen kaart toegewezen

 Kaart toegewezen

Personnel-No.
(Personeelsnr.)

Voer een personeelsnummer van max. 6
cijfers in.

1. Card No.
(Kaartnr.)

Voer een kaartnummer van max. 6 cijfers in.
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Gegevensveld/
Invoerveld

Beschrijving

2. Card No.
(Kaartnr.)

Voor alle kaarten gelden dezelfde
toegangsautorisaties.

3. Card No.
(Kaartnr.)

Speciale functie

Toestemming
voor langdurig
openen van
deuren
(kantoormodus
)

Autorisatie verlenen voor het gebruik van de
Kantoormodus bij de respectieve
geconfigureerde deuren (zie de
configuratiehandleiding).

Besturingsfunct
ie 1 activeren

Besturingsfunctie 1 wordt opgeroepen bij
de respectieve geconfigureerde lezer.

Besturingsfunct
ie 2 activeren

Besturingsfunctie 2 wordt opgeroepen bij
de respectieve geconfigureerde lezer.

Special messages on the reader (Speciale berichten op de
lezer)

Display name
(Weergavenaa
m)

Displaytekst voor kaartlezers die over deze
functie beschikken. Standaard worden de
voor- en achternaam weergegeven. Max. 20
tekens.

Text on arrival
(Tekst bij
aankomst)

Voor TA-lezers kunt u hier aangepaste
teksten invoeren die worden weergegeven
wanneer de persoon arriveert en vertrekt.
Hiervoor moet de systeemparameter Show
welcome/leaving message (Welkomst-/
vertrekbericht weergeven) zijn geactiveerd
in de Configurator-instellingen. Max. 20
tekens.

Text on
departure
(Tekst bij
vertrek)

Access control data (Toegangscontrolegegevens)

Time model
(Tijdmodel)

Selecteer een bestaand tijdmodel. De
persoon heeft alleen toegang tijdens de
gedefinieerde perioden.

PIN Invoer van PIN's voor gebruik met de lezers
met codeklavier. PIN's mogen geen reeksen
(bijv. 1234) of palindromen (bijv. 0110)
bevatten. Algemene instellingen worden
geconfigureerd in het dialoogvenster
Configurator > Settings (Instellingen).
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Gegevensveld/
Invoerveld

Beschrijving

Verification +
Confirmation
PIN (Verificatie
+ bevestigen
PIN)

Deze PIN kan automatisch worden
gegenereerd
– door het systeem of
– worden ingevoerd als een 4 tot 8

cijferige PIN (standaard = 4) in. Deze
wordt als extra beveiligingsmaatregel
gevraagd na het tonen van de kaart bij
een ingang.

Identificatie-
PIN/ ID-PIN

Deze PIN moet uniek zijn in het gehele
systeem. Deze kan automatisch worden
gegenereerd
– door het systeem of
– worden ingevoerd als een 4 tot 8

cijferige PIN (standaard = 4) in. Deze
wordt als extra beveiligingsmaatregel
gevraagd na het tonen van de kaart bij
een ingang.

De identificatie-PIN wordt vóór het opslaan
weergegeven in een berichtvenster.

Deze ID-PIN kan worden ingevoerd op lezers
met codeklavier in plaats van een kaart te
tonen. Aangezien deze PIN functioneert als
kaartnummer, bevat deze ook alle
autorisaties die aan dat kaartnummer zijn
toegewezen.

Activerings-
PIN / IDS-PIN

Voer een 4-8 cijferige PIN (standaard = 4,
met dezelfde lengte als de verificatie-PIN) in
voor activering van het alarmsysteem.
Of deze velden al dan niet worden
weergegeven, stelt u in met het
selectievakje separate IDS-PIN (aparte IDS-
PIN) (Configurator > Settings) (Configurator
> Instellingen).
Wanneer u de velden standaard instelt voor
in-/uitschakelen van het alarm, worden de
IDS (inbraakdetectiesystemen) niet
weergegeven.
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Gegevensveld/
Invoerveld

Beschrijving

Als er geen aparte activering-PIN is
ingesteld, kan er een verificatie-PIN worden
gebruikt voor activering van het IDS. Als er
echter een aparte activerings-PIN is
ingesteld, kan alleen deze worden gebruikt -
de verificatie-PIN werkt in dat geval niet als
activering-PIN.

Opmerking: een vierde variant op de PIN, de Door-PIN (deur-
PIN) kan apart worden toegewezen aan individuele deuren.
Iedereen die gebruikt maak van deze deur, moet deze code
kennen.
Deur-PIN's worden ingesteld en geactiveerd in de
configurator op de pagina Entrances (Ingangen) onder de
functie PIN or Card (PIN of kaart).

Belangrijk: tijdens het gebruik van Wiegand controllers en
lezers moet, om de identificatie-, activering- of deur-PIN's te
kunnen gebruiken, de Wiegand-kaartdefinitie PIN or Card
(PIN of kaart) (nr. 6) worden geactiveerd.

Knoppen aan de rechterkant van het dialoogvenster

Take picture
(Foto maken)

Deze knoppen zijn alleen zichtbaar wanneer
Card Personalization (CP) (Kaarten maken,
pagina 47) op dit werkstation is
geïnstalleerd en is geopend.

Preview card
(Voorbeeld
kaart)

Print card
(Kaart
afdrukken)

Print card
reverse side
(Achterkant van
kaart
afdrukken)

Acknowledgem
ent
(Bevestiging)

Import picture
(Foto
importeren)

U kunt foto's met de indeling .jpg of .bmp
importeren. De foto wordt in de weergave
van personeelsgegevens geïntegreerd.

Delete picture
(Foto
verwijderen)

Deze optie is alleen beschikbaar als een
foto is geïmporteerd.
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Gegevensveld/
Invoerveld

Beschrijving

Delete card 1
(Kaart 1
verwijderen)

Deze optie is alleen beschikbaar als een
kaart is toegewezen. Hiermee wijzigt u de
weergave van de kaartstatus (zie het
bovenstaande).

Delete card 2
(Kaart 2
verwijderen)

Delete card 3
(Kaart 3
verwijderen)

Assign card 1
(Kaart 1
verwijderen)

Hiermee wijst u de geselecteerde persoon
een kaartnummer toe en wijzigt u de
weergave van de kaartstatus (zie het
bovenstaande).

Assign card 2
(Kaart 2
toewijzen)

Assign card 3
(Kaart 3
toewijzen)

Bericht!
De identificatie en de deur-PIN-varianten kunnen niet worden gebruikt voor deurmodellen met
activering van het beveiligingssysteem (TM 10 en 14).

4.2 Kaarten toewijzen en intrekken
Iedere kaarthouder kan beschikken over maximaal drie kaarten, die afzonderlijk kunnen
worden toegewezen en ingetrokken. Afhankelijk van de configuratie van het systeem kunnen
kaartgegevens handmatig of via een registratielezer worden opgeslagen. Er kan echter slechts
één van deze methoden tegelijkertijd actief zijn: zodra een registratielezer is geconfigureerd
(Tools > Properties (Tools > Eigenschappen)), kan er niet langer handmatig worden
opgeslagen.
Handmatige gegevensopslag ondersteunt het gebruik van verschillende kaarttechnologieën,
doordat de gebruiker in staat wordt gesteld de onderliggende kaartbitformaten te wijzigen.
Wanneer er echter een registratielezer wordt gebruikt, kunnen alleen kaarten van dezelfde
onderliggende kaarttechnologie worden gebruikt.

Bericht!
In Access PE kan een kaarthouder meerdere ID-gegevens in meerdere formaten en
technologieën gebruiken. Met elk van deze ID-gegevens wordt echter dezelfde persoon met
dezelfde set autorisaties, blokkeringen, PIN's, tijdmodellen en gebiedsbeperkingen
geïdentificeerd.
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Kaarten kunnen handmatig of met een lezer worden gecontroleerd, afhankelijk van de
eigenschappen (Configuraties van registratielezers wijzigen, pagina 15). Beide modi kunnen niet
tegelijk actief zijn. Zodra een lezer is geconfigureerd, kan het kaartnummer niet meer
handmatig worden ingevoerd.

Kaarten handmatig invoeren
Als u de kaarten handmatig wilt invoeren, moeten een kaartnummer met maximaal zes cijfers
en ten minste de minimale personeelsgegevens in de naam- en personeelsgroep zijn
gedefinieerd. Voer een geldig kaartnummer in voor de persoon!
Klik op Assign card (Kaart toewijzen) om te controleren of het kaartnummer uniek is. Deze
kaart is reeds toegewezen aan de volgende persoon: xxx
Het kaartnummer wordt nu gecodeerd op basis van de standaard kaartgegevens in het
dialoogvenster General Settings (Algemene instellingen) van Access PE Configurator. Wanneer
het toewijzen is voltooid, verschijnt een bevestigingsvenster. Klik in dit venster op OK om de
gegevens op te slaan.

Als Connect to LAC Service (Verbinden met LAC-service) in Personnel Management
properties (Eigenschappen personeelsbeheer, Configuraties van registratielezers wijzigen,
pagina 15) is ingeschakeld, worden wijzigingen in of toevoegingen aan personeelsgegevens
onmiddellijk naar de LAC-service verzonden en worden ze van kracht in het hele systeem.

Bericht!
Aan een persoon moeten niet alleen een kaartnummer maar ook de autorisaties
(Authorizations (Autorisaties), pagina 42) voor alle vereiste ingangen worden toegewezen.
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Als het selectievakje Do not show dialog for editing card information (Dialoogvenster voor
bewerken van kaartgegevens niet weergeven) niet is ingeschakeld in Personnel Management
properties (Eigenschappen personeelsbeheer), opent u met de knop Assign card (Kaart
toewijzen) het volgende dialoogvenster, waarin u de standaardinstellingen kunt annuleren (zie
Access PE Configurator).

Kaart aanleren met dialooglezer
Als u een dialooglezer voor het inlezen van kaarten wilt aansluiten, moet u deze configureren
in Personnel Management Properties (Eigenschappen personeelsbeheer). In dat geval wordt
het handmatig aanleren automatisch uitgeschakeld.
In dit geval worden alle gegevens vanaf de kaart ingelezen. Het gebruik van toetsen is niet
nodig en wordt door het systeem genegeerd.
De gebruiker wordt gevraagd zijn of haar kaart voor de dialooglezer te houden, waarna de
gebruiker toegang wordt geboden of een foutmelding verschijnt.

4.3 Authorizations (Autorisaties)
Deze pagina verschijnt alleen als de gebruiker zich heeft aangemeld met beheerdersrechten
(Gebruikersrechten) om autorisaties te wijzigen.
Met de opties van dit tabblad kunnen autorisaties worden toegewezen aan personen in het
toegangscontrolesysteem. Als Configurator (dialoogvenster Authorization groups)
(Autorisatiegroepen) al is gebruikt voor het toewijzen van standaardautorisaties aan specifieke
personeelsgroepen, beschikt de betreffende persoon al over de autorisaties omdat hij/zij lid is
van de personeelsgroep.

Met de opties van dit tabblad kunnen de autorisaties van de gebruiker echter worden
aangevuld.
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Dit dialoogvenster bevat vier lijsten. De lijsten aan de rechterkant bevatten alle
geconfigureerde autorisatiegroepen (bovenste lijst) en alle geconfigureerde individuele
ingangen (onderste lijst). De totale autorisaties van een persoon bestaan uit alle
autorisatiegroepen en alle individuele ingangen die hem/haar in dit dialoogvenster worden
toegewezen.
Autorisaties (groepen of ingangen) kunnen aan een persoon worden toegewezen door in een
lijst aan de rechterkant op een autorisatie te dubbelklikken, of door een autorisatie te

selecteren en op  te klikken. Met de knop  worden alle beschikbare autorisaties
tegelijk toegewezen. U kunt een willekeurige combinatie van groepsautorisaties en individuele
autorisaties toewijzen. Toegewezen autorisaties kunnen worden ingetrokken door erop te

dubbelklikken, of met behulp van de knoppen  en .
Als autorisatiegroepen tijdmodellen bevatten (normaal gesproken zijn deze
dienovereenkomstig benoemd), mogen de ingangen die aan de groep zijn toegewezen, alleen
tijdens de betreffende tijdmodellen door die persoon worden gebruikt. Let op de speciale
gevallen in Application of time models *** XRef ME TO Anwendung_von_Zeitmodellen.xml in
Access PE.
Autorisaties zijn weliswaar standaard niet in de tijd beperkt, maar het is mogelijk om zowel
groeps- als individuele autorisaties te beperken door datums in te voeren in de kolommen
valid from (geldig van) en valid to (geldig tot). Wanneer u in deze kolommen op een cel klikt,
wordt de in-line editor voor het invoeren van datums en tijden geopend:

Datums kunnen via het toetsenbord of de muis worden ingevoerd met behulp van de kleine
pijlknoppen aan de rechterkant van de editor. Met de spatiebalk verplaatst u de cursor van
dag naar maand naar jaar, enzovoort. Door met de rechtermuisknop op een open datumveld te
klikken, kunt u een kalenderkiezer openen voor extra snelheid en comfort.
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Op die manier kunt u bij het creëren van een persoon autorisaties toewijzen die pas op een
latere datum in werking treden. Daarom is het niet nodig een herinnering in te stellen om de
autorisaties van een persoon aan te passen omdat u ze automatisch op een bepaalde datum
kunt laten vervallen. Als een valid from-datum (geldig vanaf) na een valid to-datum (geldig tot)
komt, wordt de autorisatie uitgeschakeld wanneer de valid to-datum wordt bereikt, en
opnieuw ingeschakeld wanneer de valid from-datum wordt bereikt. Dit is handig wanneer een
persoon bijvoorbeeld met vakantie gaat.
Wijzigingen in autorisaties en andere personeelsgegevens worden pas opgeslagen wanneer u
ze bevestigt door op OK te klikken. Op dat moment worden alle wijzigingen automatisch naar
de controllers verzonden, mits in Settings (Instellingen) (Tools > Properties) (Tools >
Eigenschappen) de optie Connect to LAC Service (Verbinden met LAC-service) is
ingeschakeld. In speciale gevallen kunnen de gegevens handmatig worden verzonden met de
menuopdracht Persons > Transmit selected person to LAC service (Personen >
Geselecteerde persoon naar LAC-service verzenden) of Persons > Transmit all persons to LAC
service (Personen > Alle personen naar LAC-service verzenden).

4.4 Extra velden
Dit tabblad is alleen zichtbaar wanneer ten minste een van de tien beschikbare velden voor
aanvullende gegevens is geconfigureerd in Access PE Configurator.
U kunt maximaal tien velden voor aanvullende gegevens configureren. Zowel het aantal als de
naam van deze velden kan variëren. De velden kunnen maximaal 40 tekens bevatten.
De velden worden in volgorde weergegeven. Als een van de tien velden wordt overgeslagen,
wordt een spatie weergegeven als tijdelijke aanduiding. Als het betreffende veld later wordt
geconfigureerd, vervangt het de tijdelijke aanduiding in de lijst.
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Voorzichtig!
Aan elk tekstveld wordt een veld in de database toegewezen, zodat de gegevens kunnen
worden opgeslagen, geselecteerd en in rapporten opgenomen. Dit betekent echter dat door
wijzigingen in extra gegevensvelden die in gebruik zijn, de gegevens uit de database verloren
zullen gaan. De naam van een veld voor aanvullende gegevens kan op elk ogenblik worden
gewijzigd, mits het type inhoud van het veld niet wordt gewijzigd.

4.5 Tijdmodellen toepassen
Tijdmodellen die zijn toegewezen aan personeelsgegevens, zijn alleen actief als de
standaardinstellingen van de lezer niet zijn gewijzigd, m.a.w. als de optie No time model
check (Geen controle tijdmodel) uitgeschakeld blijft.
Aangezien tijdmodellen op vele manieren kunnen worden gebruikt, moet u de volgende
conflictoplossingsregels in acht nemen om te begrijpen hoe het systeem met meerdere
toewijzingen werkt:
Als een persoon via een tijdmodel toegang heeft tot bepaalde ingangen en die persoon nu
zonder tijdmodel toegang krijgt tot dezelfde ingangen, geldt de minst strikte beperking. Dit
betekent dat in dit geval het tijdmodel niet wordt toegepast.
Voorbeeld:
Aan een persoon worden de volgende toegangsrechten toegewezen:
– Toegang tot ingang A, B, C en D binnen het tijdmodel van 09:00 tot 17:00, elke dag.
– Individuele toegangsrechten tot ingang B en D zonder tijdmodel.
Deze persoon heeft nu elke dag tussen 09:00 en 17:00 toegang tot ingang A en C, en heeft
onbeperkte toegang tot ingang B en D.
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– Als aan een persoon andere toegangsrechten voor dezelfde ingangen worden toegewezen
maar met toepassing van andere tijdmodellen, wordt de combinatie van de tijdmodellen
toegepast.

Voorbeeld:
Aan een persoon worden de volgende toegangsrechten toegewezen:
– Toegang tot ingang A, B, C en D binnen het tijdmodel van 07:00 tot 13:00, elke dag.
– Toegang tot ingang B, D, E en F binnen het tijdmodel van 09:00 tot 17:00, elke dag.
Deze persoon heeft nu van 07:00 tot 13:00 toegang tot ingang A en C, van 07:00 tot 17:00
toegang tot B en D, en van 09:00 tot 17:00 toegang tot E en F.
– Als een persoon aan een autorisatiegroep met tijdmodellen wordt toegewezen en aan

dezelfde persoon een tijdmodel met gebruik van zijn kaart wordt toegewezen, wordt het
snijpunt van de gedefinieerde perioden toegepast.

Voorbeeld:
Aan een persoon worden de volgende toegangsrechten toegewezen:
– Een autorisatiegroep met toegang tot ingang A, B, C en D en een tijdmodel van 07:00 tot

13:00, elke dag.
– Een autorisatiegroep met toegang tot ingang B, D, E en F en een tijdmodel van 09:00 tot

17:00, elke dag.
– En daarnaast een tijdmodel van 11:00 tot 19:00, elke dag.
Deze persoon heeft nu van 11:00 tot 13:00 toegang tot ingang A en C, en van 11:00 tot 17:00
toegang tot B, D, E en F.



Access Professional Edition Kaarten maken | nl 47

Bosch Security Systems B.V. Configuratiehandleiding 2019-07 | |

5 Kaarten maken
Access PE wordt geleverd met een eigen kaartpersonaliseringsprogramma. U kunt deze
software naar keuze installeren op bepaalde computers. Om kaarten te personaliseren hebt u
ook de juiste hardware nodig (camera en printer). Wij raden daarom aan dat u deze
componenten alleen installeert op de computers die u gaat gebruiken voor het personaliseren
van kaarten.
Let op: zelf de beeldimportfunctie, bijvoorbeeld voor het weergeven van beelden in het
dialoogvenster Personnel (Personeel), werkt alleen op computers waarop het
kaartpersonaliseringsprogramma is geïnstalleerd en gestart.

5.1 Kaarten maken
De functies voor het maken van kaarten kunnen worden uitgevoerd vanaf alle werkstations
waarop het programma Badge Designer is geïnstalleerd en is geopend. Het tabblad Personnel
data (Personeelsgegevens) bevat de nodige knoppen hiervoor.

Daarnaast moet de benodigde apparatuur zijn aangesloten op het werkstation: een camera en
een kaartprinter.
Als u de hardware wilt configureren, selecteert u de kaartpersonalisatieconfigurator.
Stel een camera of printer in met de ingangen op respectievelijk het tabblad Video of het
tabblad Print (Afdrukken). Raadpleeg ook de online Help van dit hulpprogramma.
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Het wordt aanbevolen de volgende procedure uit te voeren om kaarten te maken:
– Foto importeren of maken
– Afdrukvoorbeeld van kaart weergeven (optioneel)
– Voor-/achterkant van kaart afdrukken
– Ontvangstbewijs voor kaart afdrukken (optioneel)

5.2 Foto's maken of importeren
Foto's van personen, die op kaarten moeten worden afgedrukt of in het dialoogvenster met
personeelsgegevens moeten worden weergegeven, kunnen worden gemaakt met een
aangesloten camera of worden geïmporteerd uit een bestand, indien beschikbaar.

Foto's importeren
Foto's kunnen als bestanden worden geïmporteerd en aan personeelsgegevens worden
toegewezen.
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Bericht!
Foto's kunnen ook wanneer de toepassing Card Personalization niet is geïnstalleerd, worden
geïmporteerd op het werkstation. In dat geval kunnen de foto's echter alleen in het
oorspronkelijke formaat worden geïmporteerd. De hieronder beschreven opmaakfuncties zijn
dan niet beschikbaar.

Als u een foto vanuit een bestand wilt importeren, klikt u op Import picture (Foto importeren)
en selecteert u het gewenste bestand in het dialoogvenster voor bestandsselectie. Via de
configuratie-instellingen voor het programma Card Personalization definieert u een standaard
map voor geïmporteerde bestanden, die automatisch wordt geopend wanneer u de
importeerfunctie start. U kunt echter een willekeurig grafisch bestand op het systeem zoeken
en selecteren via het dialoogvenster voor bestandsselectie.
Wanneer u een bestand selecteert, wordt het weergegeven in het voorbeeldvenster zodat u
makkelijk de juiste foto kunt vinden.

Nadat u een foto hebt gekozen, verschijnt een opmaakvenster, waarin u de foto kunt bijsnijden
en verkleinen/vergroten. Het rode frame geeft het gedeelte van de foto aan dat in het systeem
wordt opgeslagen voor de desbetreffende persoon.



50 nl | Kaarten maken Access Professional Edition

2019-07 | | Configuratiehandleiding Bosch Security Systems B.V.

U kunt het geselecteerde deel van de foto in het frame verplaatsen door het met de
linkermuisknop te verslepen.

U kunt het geselecteerde deel van de foto ook vergroten door met de linkermuisknop te
klikken, de muisknop ingedrukt te houden en met de muis uit te rekken. Op die manier kunnen
zelfs kleine delen van een foto voor een kaart worden gebruikt, mits de resolutie van de foto
hoog genoeg is.
Klik op OK om het geselecteerde deel van de foto te importeren.
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De framegrootte wordt aangepast aan de grootte van het frame in het dialoogvenster en/of het
fotoframe in de gedefinieerde kaartlay-out, en daar weergegeven onmiddellijk nadat het
importeren is bevestigd.

Foto maken
De toepassing Card Personalization (CP) voor het maken van kaarten moet worden
geconfigureerd voor het cameratype dat op het werkstation is aangesloten. U doet dit via het
dialoogvenster CP Configuration (CP-configuratie). Raadpleeg het Help-bestand van de
toepassing voor meer informatie over de mogelijke instellingen.
De volgende schermafbeeldingen zijn gemaakt in Video for Windows maar zijn afhankelijk van
het cameratype dat u gebruikt.
Klik op de knop Take picture (Foto maken) om het volgende dialoogvenster te openen:

Indien nodig kunt u de huidige camera-instellingen controleren en wijzigen met de knop .
Als de instellingen correct zijn, kunt u het beeld stilzetten met de knop Freeze (Stilzetten).
U kunt de modus Live image (Live-beeld) op elk gewenst moment weer activeren in geval het
stilgezette beeld niet naar wens is. Als de foto voor kaarten en personeelsgegevens moet
worden gebruikt, klikt u op Apply (Toepassen).
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Het dialoogvenster Crop picture (Foto bijsnijden) wordt geopend. Met behulp van een
snijframe kunt u het deel van de foto selecteren dat u op de kaart wilt afdrukken.
Lees de paragraaf over foto's importeren hiervóór voor meer informatie over het snijframe.

5.3 Kaarten vooraf bekijken en afdrukken
 De knoppen Preview card (Afdrukvoorbeeld van kaart) en Print card reverse side (Achterkant
van kaart afdrukken) zijn alleen actief als kaart-lay-outs zijn toegewezen aan de
overeenkomstige personeelsgroep in Access PE Configurator (dialoogvenster: Personnel
Groups (Personeelsgroepen))

Preview card (Voorbeeld kaart)
Nadat de foto is gemaakt, wordt deze automatisch in de vooraf gedefinieerde zone van de
kaart-lay-out ingevoegd, zodat u de kaart kunt bekijken voordat deze wordt afgedrukt. U
bekijkt het voorbeeld van de kaart in het volgende dialoogvenster, dat u oproept met de knop
Preview card (Afdrukvoorbeeld van kaart).

Sluit het dialoogvenster door te klikken op OK

Print card (Kaart afdrukken)
Als de lay-out van de kaart naar wens is, kunt u de kaart bij de laatste stap afdrukken. Met de
knop Print card (Kaart afdrukken) roept u het volgende dialoogvenster op, dat identiek is aan
het vorige, behalve dat het ook een afdrukopdracht bevat.
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Als u het afdrukken wilt starten, klikt u op de knop Print (Afdrukken) om een dialoogvenster te
openen waarin u printer kunt selecteren. Als een standaardprinter is gedefinieerd in
Configurator, wordt het afdrukken onmiddellijk gestart.

Print card reverse side (Achterkant van kaart afdrukken)
Als de achterkant van de kaart moet worden afgedrukt, kunt u hiervoor een speciale lay-out en
inhoud definiëren.
Let op: zorg dat de kaarten waarvan de voorkant al is afgedrukt, bovenaan in de papierlade
van de kaartprinter liggen voordat u de opdracht voor het afdrukken van de achterkant kiest.
Tip: wij raden u aan alleen algemene en geen persoonsgegevens op de achterkant af te
drukken. Hierdoor kunt u de achterkant van een groot aantal kaarten vooraf afdrukken en op
voorraad houden. Dit versnelt het maken van complete kaarten voor individuele personen
wanneer nodig.
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5.4 Ontvangstbewijzen voor kaarten afdrukken
 Een andere functie van de toepassing voor het maken van kaarten is de mogelijkheid om een
standaard ontvangstbewijs af te drukken. Het ontvangstbewijs geeft aan dat de kaarthouder
de kaart heeft ontvangen en de kaarthouder kan informatie over de gegevens op de kaart
ontvangen.
Als u deze functie wilt gebruiken, moet u een sjabloon voor de personeelsgroep maken en
opslaan in Access PE Configurator, dialoogvenster: Personnel Groups (Personeelsgroepen).
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6 Rapporten
U kunt de lijstfuncties in Access PE gebruiken om de database-inhoud op een bepaalde manier
te verzamelen en te structureren in een duidelijk afdrukformaat.
Om de resultaten zo te filteren dat alleen gegevens worden getoond die relevant zijn voor de
betreffende gebruiker kunt u vooraf ingestelde lay-outs gebruiken, die specifieke informatie
geven over een bepaald aspect van toegangscontrole (bijvoorbeeld wie over welke autorisaties
voor bepaalde deuren beschikt).

6.1 Rapporten

Klik op de knop  om van de personeelsgegevensweergave om te schakelen naar een
dialoogvenster voor het maken en weergeven van rapporten met betrekking tot
toegangscontrole.
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U beschikt over een aantal rapport-lay-outs en inhoudsfilters:

Lay-out Beschikbare filters Beschrijving

Personnel
data
(Personeel
sgegevens)

Last name
(Achternaam)
First name
(Voornaam)
Personnel No.
(Personeelsnr.)
Kaartnr.
Kaartnr. van ... tot
Dept./Company
(Afd./Bedrijf)
Personnel Group
(Personeelsgroep)

Hiermee geeft u
personeelsgegevens weer.
De gegevens kunnen
worden gefilterd met
behulp van een of meer
beschikbare filters. Bij het
gebruik van meerdere filters
zijn deze beperkend
(logische EN).
U kunt bijvoorbeeld alle
personen zoeken waarvan
de naam begint met A en
het kaartnummer zich
tussen 900 en 999 bevindt.
Het sterretje (*) kan als
jokerteken worden
gebruikt om een of meer
tekens, of geen enkel
teken te
vertegenwoordigen.

Blocked
Persons
(Geblokkee
rde
personen)

Last name
(Achternaam)
First name
(Voornaam)
Personnel no.
(Personeelsnr.)
Kaartnr.
Kaartnr. van ... tot
Dept./Company
(Afd./Bedrijf)
Personnel Group
(Personeelsgroep)

Hiermee geeft u de
gegevens weer van
personen met een andere
kaartstatus dan valid
(geldig) (bijv. explicitly
blocked (expliciet
geblokkeerd), 3x wrong PIN
input (3x onjuiste invoer
PIN-code) of selected for
random screening
(geselecteerd voor
willekeurige controle)) in
het hoofdscherm voor
personeelsgegevens.
De gegevens kunnen
worden gefilterd met
behulp van een of meer
beschikbare filters. Bij het
gebruik van meerdere filters
zijn deze beperkend
(logische EN).
U kunt bijvoorbeeld alle
personen zoeken waarvan
de naam begint met A en
het kaartnummer zich
tussen 900 en 999 bevindt.
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Lay-out Beschikbare filters Beschrijving

Het sterretje (*) kan als
jokerteken worden
gebruikt om een of meer
tekens, of geen enkel
teken te
vertegenwoordigen.

Persons -
Authorizati
ons
(Personen -
Autorisatie
s)

Last name
(Achternaam)
First name
(Voornaam)
Personnel No.
(Personeelsnr.)
Kaartnr.
Kaartnr. van ... tot
Dept./Company
(Afd./Bedrijf)
Personnel Group
(Personeelsgroep)
Authorizations
(Autorisaties)

Hiermee geeft u een
overzicht van personen en
de toegewezen autorisaties
weer. Groepsautorisaties
zijn gemarkeerd met (G),
individuele autorisaties met
(E). Ook de geldigheidsduur
wordt weergegeven.
U kunt desgewenst op een
of meer autorisaties
filteren. Voor het selecteren
van een autorisatie of het
opheffen van de selectie
ervan volstaat één muisklik.

Persons -
Areas
(Personen -
Gebieden)

Last name
(Achternaam)
First name
(Voornaam)
Personnel No.
(Personeelsnr.)
Kaartnr.
Kaartnr. van ... tot
Dept./Company
(Afd./Bedrijf)
Personnel Group
(Personeelsgroep)
Locaties

Op basis van de gebieden
die in het systeem zijn
geconfigureerd, wordt
zowel de naam van de
personen in de
geselecteerde ruimte als
het aantal personen in die
ruimte weergegeven.
U kunt desgewenst op een
of meer gebieden filteren.
Voor het selecteren van een
gebied of het opheffen van
de selectie ervan volstaat
één muisklik.

Authorizati
ons -
Persons
(Autorisatie
s -
Personen)

Authorizations
(Autorisaties)

Hiermee geeft u een
overzicht van autorisaties
en de daaraan toegewezen
personen weer.
Groepsautorisaties zijn
gemarkeerd met (G),
individuele autorisaties met
(E). Ook de geldigheidsduur
wordt weergegeven.
U kunt desgewenst op een
of meer autorisaties
filteren. Voor het selecteren
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Lay-out Beschikbare filters Beschrijving

van een autorisatie of het
opheffen van de selectie
ervan volstaat één muisklik.

Apparaten: Device type
(Apparaattype)
Device description
(Apparaatomschrij
ving)

Hiermee geeft u een
overzicht van apparaattypen
weer (zoals controllers,
ingangen en lezers).
U kunt desgewenst op een
of meer apparaattypen
filteren. Voor het selecteren
van een apparaattype of het
opheffen van de selectie
ervan volstaat één muisklik.
Apparaten kunnen worden
gefilterd op tekst uit hun
omschrijving. U kunt
bijvoorbeeld alle apparaten
weergeven waarvan de
omschrijving begint met A.
Het sterretje (*) kan in de
apparaatomschrijving als
jokerteken worden gebruikt
om een of meer tekens, of
geen enkel teken te
vertegenwoordigen.

Users
(Gebruiker
s)

Last name
(Achternaam)
First name
(Voornaam)
Personnel No.
(Personeelsnr.)
Kaartnr.
Kaartnr. van ... tot
Dept./Company
(Afd./Bedrijf)
Personnel Group
(Personeelsgroep)

Hiermee geeft u een
overzicht weer van
personen die ook
systeemgebruiker zijn,
evenals de
gebruikersrechten die aan
de betreffende personen
zijn toegewezen.
De gegevens kunnen
worden gefilterd met
behulp van een of meer
beschikbare filters. Bij het
gebruik van meerdere filters
zijn deze beperkend
(logische EN).
U kunt bijvoorbeeld alle
personen zoeken waarvan
de naam begint met A en
het kaartnummer zich
tussen 900 en 999 bevindt.
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Lay-out Beschikbare filters Beschrijving

Het sterretje (*) kan als
jokerteken worden
gebruikt om een of meer
tekens, of geen enkel
teken te
vertegenwoordigen.

Persons -
Doors
(Personen -
Deuren)

Last name
(Achternaam)
First name
(Voornaam)
Personnel No.
(Personeelsnr.)
Kaartnr.
Kaartnr. van ... tot
Dept./Company
(Afd./Bedrijf)
Personnel Group
(Personeelsgroep)
Authorizations
(Autorisaties)

Hiermee geeft u een
overzicht van personen en
de toegewezen deuren
weer. Groepsautorisaties
zijn gemarkeerd met (G),
individuele autorisaties met
(E). Ook de geldigheidsduur
wordt weergegeven.
Personen kunnen worden
gefilterd op tekst,
bijvoorbeeld alle personen
waarvan de naam begint
met A.
Het sterretje (*) kan in de
apparaatomschrijving als
jokerteken worden gebruikt
om een of meer tekens, of
geen enkel teken te
vertegenwoordigen.

6.2 Rapporten: paginaweergave
Het is mogelijk filters in te stellen om de rapportinhoud te beperken tot een subset. Als u geen
filter instelt, worden alle gegevens opgenomen in het rapport. Klik op de knop Search
(Zoeken) om het ophalen van gegevens te starten en ze weer te geven in een
voorbeeldvenster.

Bericht!
Bij het wijzigen van de filtercriteria wordt het aanbevolen de knop Clear form (Formulier
wissen) te gebruiken om onbedoeld filteren en misleidende rapporten te voorkomen.

Geopende logboekbestanden kunnen worden opgeslagen of worden afgedrukt. Via het menu-

onderdeel File > Print (Bestand > Afdrukken of de knop  wordt een voorbeeld geopend.
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Bericht!
Alle geopende logboekbestanden worden afgedrukt.
Sluit alle bestanden die niet hoeven te worden afgedrukt, of beperk de selectie voor de
belangrijke berichten.

De rapportpaginaweergave biedt een aantal functies voor het wijzigen en bedienen van de
weergave:

Knop Betekenis Beschrijving

Exporteren De lijst kan voor verdere
verwerking worden geëxporteerd
naar een bestand. De volgende
bestandsindelingen zijn
beschikbaar:
Acrobat Portable Document
Format (PDF)
Door komma's gescheiden
waarden (CSV)

Afdrukken Hiermee drukt u het rapport af via
een afdrukvenster waarin u een
standaardprinter kunt instellen.

Pagina
selecteren

Met de pijlknoppen gaat u naar de
eerste, vorige, volgende of laatste
pagina van het rapport. Dit
besturingselement geeft ook het
huidige paginanummer en het
totale aantal pagina's in het
rapport weer.

Aantal
pagina´s

Vraagt om de huidige pagina en
het totale aantal pagina's.
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Knop Betekenis Beschrijving

In-/
uitzoomen

U kunt desgewenst een andere
schaal dan de standaardschaal
van de weergave (100%)
selecteren.

Lijsten exporteren
Druk op de knop  om een dialoogvenster te openen waarin de exportcriteria kunnen worden
ingevoerd.

Het selectielijstveld Format (Formaat) biedt de uitgangsformaten .pdf (voor het doorsturen en
archiveren van specifieke zoekresultaten) en .csv (voor verdere gegevensverwerking).
Wanneer gegevens naar een csv-bestand worden geëxporteerd, kunnen deze in zekere mate
verder worden verwerkt.

Naast de begrenzings- en exportmodus kunt u ook rapport- en paginasecties (kolomkoppen
en paginadetails) en groepsecties (geselecteerde gegevens) van export uitsluiten of isoleren.
U kunt een van de volgende opties gebruiken als Destination (Bestemming).
– Application (Toepassing) — opent het bestand met de juiste toepassing. Deze toepassing

moet ook op de computer worden geïnstalleerd. Pdf-bestanden worden geopend met
Adobe Acrobat Reader en csv-bestanden worden geopend met MS Excel.
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– Disk file (Schijfbestand) (standaard) — opent een Explorer-dialoogvenster waarin u de
gewenste map kunt selecteren. Er wordt een naam voorgesteld waarmee het bestand kan
worden opgeslagen.

– Exchange folder (Exchange-map) — het bestand kan direct naar een MS Outlook-
ontvanger worden verzonden.

– Lotus Domino Mail — het bestand kan direct naar een Lotus Mail-ontvanger worden
verzonden.
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7 Lokale opnamen
Momentopnamen en video's opnemen
De videosequenties die worden weergegeven via de dialoogvensters van het
toegangscontrolesysteem, worden genomen van de video-opnameapparaten waarop de
geconfigureerde bewakingscamera's zijn aangesloten. Afhankelijk van de opslagcapaciteit van
het apparaat worden de oudste opnamen overschreven door de nieuwste opnamen
(ringvormige buffer).
Om bepaalde gedeeltes te bewaren kunt u lokale kopieën van losse beelden of video's
kopiëren. Als u het standaard installatiepad gebruikt, worden beelden en video's bewaard
onder C:\BOSCH\Access Professional Edition\PE\Data\Video.

Druk op de knop  om een momentopname in jpg-formaat op te slaan als
<apparaatnaam>_jjjjMMdduummsstttt.jpg
[j= jaar, M= maand, d= dag, u= uur, m= minuten, s= seconden, t= duizendsten van seconden].

Druk op de knop  om te beginnen met het opslaan van de sequentie die momenteel
wordt uitgevoerd; druk nogmaals op de knop om de sequentie te beëindigen. Deze lokale
kopie van de video-opname heeft dezelfde naamgeving als de beelden en wordt opgeslagen
in .vxx- of .mpeg-formaat. Om het .vxx-formaat als video te bekijken kunt u geen standaard
marktproduct gebruiken. Om deze lokale kopieën te kunnen bekijken moet u de meegeleverde
Bosch Video Player gebruiken.

Druk op de knop  om een momentopname van de huidige weergave van een Point of
Interest (POI, interessepunt) op te slaan. _POI wordt toegevoegd aan het begin van de
bestandsnaam: _POI <apparaatnaam>_jjjjMMdduummsstttt.jpg.
[j= jaar, M= maand, d= dag, u= uur, m= minuten, s= seconden, t= duizendsten van seconden].
Er wordt ook een logboekbericht gemaakt als markering.

Bosch Video Player
De momentopnamen kunnen worden geopend met nagenoeg elk viewerprogramma of elke
internetbrowser. De video-opnamen hebben echter een speciaal formaat en moeten worden
geopend met de Bosch Video Player.

Bericht!
U kunt de videosequenties die zijn opgeslagen in .mpeg-formaat met elke willekeurige speler
weergeven.

Het dialoogvenster is bewust eenvoudig gehouden en heeft slechts twee knoppen naast het
videoweergaveveld, namelijk open file (bestand openen) en start/stop.
Druk op open file om in de standaard opslaglocatie van de video-opname te bladeren (C:\)
naar de gewenste bestanden.
Nadat u het videobestand hebt geselecteerd, wordt het pad weergegeven in de Video Player. U
het geselecteerde bestand op elk moment weergeven door op start te drukken. Terwijl de
video wordt afgespeeld verandert de startknop in stop, zodat u het afspelen kunt
onderbreken.
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8 Gebruikersrechten configureren
De gebruikersnaam en het wachtwoord van het standaard beheerdersaccount van het systeem
is bosch. Wijs aan dit account onmiddellijk een sterk wachtwoord toe, en gebruik het om het
beheerdersaccount en accounts zonder rechten in te stellen met sterke wachtwoorden.
De gebruikersrechten voor Access PE-toepassingen (en voor Configurator en LogViewer)
worden in Personnel Management toegewezen in het dialoogvenster Personnel Data and
authorizations (Personeelsgegevens en autorisaties) > tabblad User Rights
(Gebruikersrechten).
Dit tabblad is alleen zichtbaar voor gebruikers met beheerdersrechten. Alleen beheerders
kunnen hun eigen rechten en die van andere gebruikers instellen en wijzigen.

Als een persoon gebruikersrechten voor Access PE-toepassingen moet ontvangen, moeten
deze expliciet worden toegewezen. Alle personen worden standaard zonder gebruikersrechten
geconfigureerd.
Als u gebruikersrechten wilt toewijzen, voert u een gebruikersnaam en een wachtwoord in.
Standaard wordt de achternaam van de persoon voorgesteld als gebruikersnaam, maar u kunt
optioneel een andere gebruikersnaam opgeven. Het wachtwoord kan maximaal 16 tekens
bevatten, is hoofdlettergevoelig, en mag speciale tekens bevatten.

Bericht!
Verantwoordelijkheid verzekeren
Houd afzonderlijke gebruikersaccounts bij in plaats van generieke. Alle gegevensvermeldingen
en -wijzigingen worden per gebruikersnaam geregistreerd. Verzeker u ervan dat gebruikers
overdracht uitvoeren bij wisseling van ploegen.
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Het enige verschil tussen beheerders en normale gebruikers is dat beheerders
gebruikersrechten kunnen toewijzen en wijzigen. Alle gebruikerstypen zijn identiek op het
gebied van de beschikbaarheid van toepassingen of de toegang tot gegevens en
logboekbestanden. Elke nieuwe gebruiker kan met beperkte of onbeperkte gegevenstoegang
worden geconfigureerd.
De volgende gebruikersrechten kunnen worden toegewezen:

Toe-
passing

Gebruikersrecht Beschrijving

Personnel
data
(Personeel
sgegevens)

View personnel
data
(Personeelsgege
vens
weergeven)

Alleen het dialoogvenster met personeelsgegevens kan worden opgeroepen. De
locatie van personen wordt niet weergegeven. Wijzigingen zijn niet toegestaan.

Edit personnel
data
(Personeelsgege
vens bewerken)

De personeelsgegevens kunnen worden weergegeven en gewijzigd. De locatie van
personen wordt niet weergegeven.

Change location
(Locatie
wijzigen)

Deze optie kan alleen in combinatie met een van de bovenstaande opties worden
gebruikt.
Als View personnel data (Personeelsgegevens weergeven) is geactiveerd, kunnen
locaties alleen worden weergegeven.
Als Edit personnel data (Personeelsgegevens bewerken) is geactiveerd, kunnen
locaties ook worden gewijzigd.

Toegangsautoris
aties wijzigen

Het tabblad Access authorizations (Toegangsautorisaties) is alleen beschikbaar
als dit selectievakje is ingeschakeld.

Configurat
or

Configuration of
system
(Systeemconfig
uratie)

Met deze optie activeert u de volledige gebruikersrechten voor Configurator.

Door
manageme
nt
(Deurbehe
er)

Open /lock door
(long-term)
(Deur openen/
vergrendelen
(langdurig))

Deurbeheer wordt geactiveerd voor het menu met dezelfde naam, en via het
snelmenu in de lijst van apparaatstatussen (in Personnel management en Log
viewer).

Log viewer View own
message (Eigen
melding
weergeven)

Hiermee worden alle logboekmeldingen gefilterd, behalve de meldingen die
betrekking hebben op de gebruiker zelf.

View all
messages
without
personal data
(Alle meldingen
zonder

Hiermee worden alle logboekmeldingen weergegeven maar zijn de
personeelsgegevens niet zichtbaar.
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Toe-
passing

Gebruikersrecht Beschrijving

personeelsgege
vens
weergeven)

View all
messages (Alle
meldingen
weergeven)

Hiermee worden alle meldingen ongecensureerd weergegeven.

Procedure voor het instellen van nieuwe gebruikers

1. Start Access PE Personnel Management met het bureaubladpictogram  en meld
u aan met de voorgeconfigureerde Gebruiker-beheerder-account.

2. Open het dialoogvenster om personeelsgegevens toe te voegen met de knop  of via
het menu Persons > New Person (Personen > Nieuwe persoon)

3. Voeg een nieuwe gebruiker toe door ten minste een naam en een personeelsgroep in te
voeren

4. Klik op het tabblad User Rights (Gebruikersrechten) en
– wijzig, indien nodig, de gebruikersnaam
– wijs een wachtwoord toe
– specificeer het type gebruiker (User (Gebruiker) of User-Administrator (Gebruiker-

beheerder)).
– wijs rechten om gegevens te wijzigen toe aan deze gebruiker.
– Bevestig uw invoer en sluit het dialoogvenster door op OK te klikken.

5. Meld u af bij Personnel Management (Personeelsmanagement) door te klikken op 
of via het menu Extras > Logon (Extra > Aanmelden) en bevestig de veiligheidscontrole
door met Yes (Ja) te antwoorden.

6. Gebruik de knop  of het menu nogmaals om u aan te melden met de gegevens van
de gebruiker die u net hebt toegevoegd.

8.1 Gebruikersoverdracht en werkstationbeveiliging
Gebruikersoverdracht
Als een gebruiker de controle overdraagt op een andere gebruiker op hetzelfde werkstation,
moeten ze een formele overdracht uitvoeren. Zodoende wordt verzekerd dat alle acties op
juiste wijze worden gekoppeld aan de gebruiker die ze heeft uitgevoerd.
1. Eerst moet de huidige gebruiker zich afmelden. Hiertoe klikt deze gebruiker op de

werkbalkknop . Er wordt een veiligheidscontrole uitgevoerd: Do you want to end
your work with user rights? (Wilt u uw werkzaamheden met gebruikersrechten
beëindigen?)

2. Na bevestiging gaat het systeem terug naar het hoofddialoogvenster van de toepassing.
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3. Vervolgens moet de nieuwe gebruiker zich aanmelden door op de knop  te klikken.

Werkstationbeveiliging
Bescherm persoonlijke gegevens tegen onbevoegde toegang bij tijdelijke onbemande
werkstations. Hiervoor zijn verschillende oplossingen beschikbaar:
– U wordt aangeraden Configurator en Log Viewer niet op dergelijke werkstations te

installeren.
– Meld u af bij Personnel Management wanneer het programma niet in gebruik is. Klik

hiervoor op de knop  zodat de veiligheidscontrole wordt uitgevoerd, zoals
hierboven is beschreven. De personeelslijst blijft zichtbaar maar er is geen toegang meer
mogelijk tot de personeelsgegevens.

– Sluit de toepassing met File > Exit (Bestand > Afsluiten) of klik op de x-titelbalkknop van
het venster. Als u de personeelslijst wilt raadplegen, moet u de toepassing opnieuw
starten.

– Vergrendel de computer met behulp van de standaard Windows-functie: Druk op Ctrl +
Alt + Del en selecteer Lock Computer (Computer vergrendelen) in de weergegeven
systeemfuncties. Aangezien dit de standaardfunctie is, kunt u Lock Computer (Computer
vergrendelen) doorgaans sneller uitvoeren door gewoon op Enter te drukken. Alleen de
huidige gebruiker of een gebruiker met Windows-beheerdersrechten kan het systeem nu
ontgrendelen.
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9 Dreigingswaarschuwingen activeren en annuleren
Inleiding
Een dreiging is een kritieke situatie waarvoor een directe en gelijktijdige reactie van sommige
of alle ingangen in een toegangscontrolesysteem vereist is.
Een dreigingswaarschuwing is een alarm als reactie op een dreiging. Afhankelijk van de
instellingen in Access PE Configurator kunnen ingangen op verschillende manieren reageren
op dreigingswaarschuwingen.
Personen met de juiste autorisatie kunnen een dreigingswaarschuwing maken met één enkele
actie, bijvoorbeeld via de gebruikersinterface van Access PE, door op een knop te drukken of
door een speciale ID-kaart te tonen.

Voorwaarden
– Om te kunnen reageren op een dreigingswaarschuwing, moet de systeemhardware

worden geconfigureerd in het Configurator-programma. Zie de volgende gedeelten in de
Help van Configurator voor details:
– Een ingangssignaal toewijzen voor dreigingswaarschuwingen
– De reacties van ingangen op een dreigingswaarschuwing definiëren

– Om een dreigingswaarschuwing te kunnen instellen of deactiveren via de dialoogvensters
van Access PE, moet de gebruiker van een dialoogvenster beschikken over het
gebruikersrecht Open / lock door (long-term) (Deur openen/vergrendelen (langdurig)). 
Dubbelklik in het programma Access PE Configurator op de dialoogvenstergebruiker in de
hoofdpersoneelslijst > Personnel data and authorizations (Personeelsgegevens en
rechten) > User Rights (Gebruikersrechten) en schakel het selectievakje Open / lock
door (long-term) (Deur openen/vergrendelen (langdurig) in.

– Elke persoon kan een dreigingswaarschuwing instellen via hardware (bijvoorbeeld, een
drukknop) of via een kaart voor dreigingswaarschuwing, vooropgesteld dat de
desbetreffende persoon toegang hiertoe heeft.

Overzicht
Een gebruiker van een Access PE-systeem kan een dreigingsactivering activeren door op de
knop Set Threat Alert (Dreigingswaarschuwing instellen) te klikken in de programma's:
Alarmbeheer, Personnel Management en Logviewer.
Elke persoon kan een dreigingswaarschuwing activeren op een van de volgende manieren:
– Met een drukknop of andere schakelaar die is verbonden met het AMC-ingangssignaal dat

is toegewezen voor dreigingswaarschuwingen in Access PE Configurator.
– Door een speciale kaart voor dreigingswaarschuwingen te tonen bij een willekeurige

toegangslezer.

Alleen een Access PE-systeemgebruiker met de juiste autorisatie kan een
dreigingswaarschuwing deactiveren door te klikken op de knop Deactivate Threat Alert
(Dreigingswaarschuwing deactiveren) in een van de toepassingen. Om veiligheidsredenen
kunnen ze deze niet annuleren met de kaart voor dreigingswaarschuwingen.

9.1 De knoppen Set/Deactivate Threat Alert
(Dreigingswaarschuwing instellen/deactiveren) gebruiken
De knop Set Threat Alert (Dreigingswaarschuwing instellen) heeft een prominente plaats op
de startschermen van de volgende Access PE-toepassingen:
– Personnel Management
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– Alarm and Map Management
– Logviewer

<->

Procedure
1. Klik op de knop Set Threat Alert (Dreigingswaarschuwing instellen) en bevestig dit in het

pop-upvenster.
De knop verandert in Deactivate Threat Alert (Dreigingswaarschuwing deactiveren).

2. Wanneer de dreiging is opgelost, klikt u op de knop Deactivate Threat Alert
(Dreigingswaarschuwing deactiveren) en bevestig dit in het pop-upvenster.
De knop verandert weer in Set Threat Alert (Dreigingswaarschuwing instellen).

Bericht!
'Geblokkeerde' (beveiligde) deuren
Een ingang die expliciet is ingesteld op door blocked (deur geblokkeerd, beveiligd) blijft
beveiligd wanneer een dreigingswaarschuwing wordt gedeactiveerd via de knop Deactivate
Threat Alert (Dreigingswaarschuwing deactiveren). Een beveiligde status moet expliciet bij
de deur worden gedeactiveerd, om verdere beveiligingsinbreuken na
dreigingswaarschuwingen te voorkomen.
Dialoogvensterpad:
Hoofdscherm Personnel Management (Personeelsbeheer) > structuur Device states
(Apparaatstatussen) > klik met de rechtermuisknop op de beveiligde ingang (gemarkeerd met
een hangslot) om het snelmenu te openen.

9.2 Kaarten voor dreigingswaarschuwingen
Overzicht
Een kaart voor dreigingswaarschuwingen is een speciale referentie die aan elke willekeurige
kaarthouder kan worden toegewezen door een Gebruiker-beheerder (d.w.z. door iedereen die
beschikt over het gebruikersrecht om personen in te stellen en wijzigen in het Access PE-
systeem).
De kaart voor dreigingswaarschuwingen biedt geen toegang bij ingangen, maar activeert in
plaats hiervan een dreigingswaarschuwing wanneer de kaart wordt getoond bij elke
willekeurige kaartlezer in het Access PE-systeem.
De kaart voor dreigingswaarschuwingen kan de dreigingswaarschuwing niet deactiveren.
Alleen systeembeheerders kunnen de dreigingswaarschuwing deactiveren door te klikken op
de knop Deactivate Threat Alert (Dreigingswaarschuwing deactiveren) op de startschermen
van de volgende Access PE-toepassingen:
– Personnel Management
– Alarm and Map Management
– Logviewer

Kaarten voor dreigingswaarschuwingen toewijzen aan personeel
1. Meld u aan bij de toepassing Personnel Management als Gebruiker-beheerder.
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2. Dubbelklik in de lijst met kaarthouders op de kaarthouder waaraan de kaart voor
dreigingswaarschuwingen moet worden toegewezen.
Het dialoogvenster Personnel Data and authorizations (Personeelsgegevens en
autorisaties) wordt geopend.

3. Selecteer de tab Personnel Data (Personeelsgegevens).
4. Klik op de knop Assign card for threat alert activation (Kaart voor activering van

dreigingswaarschuwingen toewijzen)
5. De volgende stap is afhankelijk van de aanwezigheid of afwezigheid van een

registratielezer:
– Als een registratielezer, zoals gebruikelijk, is geconfigureerd op uw werkstation, volgt

u de gebruikelijke procedure voor het toewijzen van de kaart aan een persoon.
– Als er geen registratielezer is geconfigureerd, moet u kaartgegevens handmatig

invoeren.

Beide procedures worden beschreven in het gedeelte Kaarten toewijzen en
intrekken. Zie de koppeling aan het einde van dit gedeelte.

De kaart met de overeenkomstige interne kaartinformatie zal nu een dreigingswaarschuwing
activeren wanneer de kaart wordt getoond bij een van de kaartlezers van het systeem.

Kaarten voor dreigingswaarschuwingen verwijderen bij personeel
1. Dubbelklik in de lijst met kaarthouders op de kaarthouder waarvoor de kaart voor

dreigingswaarschuwingen moet worden verwijderd.
Het dialoogvenster Personnel Data and authorizations (Personeelsgegevens en
autorisaties) wordt geopend.

2. Selecteer de tab Personnel Data (Personeelsgegevens).
3. Klik op de knop Delete card for threat alert activation (Kaart voor activering van

dreigingswaarschuwingen verwijderen)
4. Bevestig de verwijdering in het pop-upvenster.

De kaart zal geen dreigingswaarschuwing meer activeren wanneer de kaart wordt getoond bij
een van de kaartlezers van het systeem.

Zie ook
– Kaarten toewijzen en intrekken, pagina 40
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10 UL 294-vereisten
Functies die niet zijn geëvalueerd door UL:
– Het systeem van videoverificatie
– Plattegrondweergave en alarmbeheer met plattegrond- en videoverificatie
– Video Player
– Badge Designer
– De Delta 1200 Series
– Rosslare ARD-1200EM Series
– LAC-controllers
– LACi-controllers
– APC-AMC2-4R4CF-controllers

– BG 900-lezer met interfaceprotocol
– L-BUS-lezer met interfaceprotocol

– IDS van beveiligingssysteem - In-/uitschakelen van alarm
– Liftgebruik
– Teksten
– Logboek
– Personnel Management (Personeelsbeheer)
– Kaarten maken
– Rapporten
– Gebruikersrechten
– Gebruik van inbraakalarm

Functies die zijn geëvalueerd door UL:
– 26-bits Wiegand-formaatlezers
– AMC2-controllers:

– APC-AMC2-4WCF
– API-AMC2-4WE
– API-AMC2-8IOE
– API-AMC2-16IOE

– APE-SW als aanvullende bewakingsapparatuur
De volgende Bosch-kaartlezers zijn door UL geëvalueerd voor compatibiliteit met het APE-SW-
softwaresysteem van Bosch:
– LECTUS secure 1000 WI
– LECTUS secure 4000 WI
– LECTUS secure 5000 WI
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